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Basic Image Processing
* What is a digital image?

* What makes a good image”?
Correct image acquisition

Signal to Noise

Resolution and Sampling

* The basics of image processing
Golden rules of image processing

Conceptual Hierarchy of Image Processing

Low Level Processing:
Display (Figures)
Filtering

Mid - Level Processing:
Segmentation
Spectral unmixing

High -Level Processing / Analysis:
Colocalisation
Tracking
Statistics



What is a digital image?




What is a digital image?

An image represents the output of the optics and detector of the imaging system

image = object
image = object ® PSF

e A digital image is a numerical array:
elements = pixels or voxels with:
- defined size (sampling resolution)
- defined no. of grey levels (bit depth)

e In addition to “useful” signal there is:
- dark signal from the detector
- autofluorescence (background)
- statistical noise of photon detection

@ Details are detected within the limitations of:
- the imaging optics
= woewmw e 0w = the sampling rate (pixel size)
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Image Parameters - what to record (= image metadata)




Image Parameters - what to record (= image metadata)

® Type of imaging — Wide-field fluorescence

@® Excitation and Emission wavelengths 490/520

@® Optics used — x60 NA 1.2 water immersion

® Image pixel dimensions — 212x212 (x200) nm

@® Depth or Dynamic range — 8 bit; 256 greys

@® Any processing performed
- 12 bit to 8 bit conversion
- contrast adjustment

Wide-field fluorescence 490 ex 520 em ® Display parameters - range 0-255, grey scale
X60 1.2 WI -gamma = 1

Xy 212 nm; 60 (z step 200 nm)

Bin 2x2

250 ms exposure @® The Biology - Drosophila stage 8 egg chamber

Contrast stretched to fill 8 bit display - Tau GFP, labelling microtubules
Tau-GFP Oocyte

Open Microscopy Environment http://www.openmicroscopy.org/
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OME - Open Microscopy Environment

* Douglas Russell, Lecture 18: Image Management *

® Purpose: Supporting Metadata Management for Microscopy
avoids problems of image formats
archiving and retrieval
data sharing
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What makes a good image?




Correct Image Acquisition

® The system must be correctly set up and aligned
- PSF verification (beads)

® The specimen should not cause undue optical aberration
- mounting / appropriate optics

® Avoid underflow and overflow but fill the dynamic range
- use a colour LUT

| |
B | - beware of auto-intensity scaling

® Take a dark signal image and/or background
— Dark subtraction processing

® Be aware of XYZ optical resolution of the system and sample appropriately
- PSF of the imaging system
- Pixel (voxel in 3D) size in the image

@® Take care with signal to noise limitations
- collect enough light: integrate, average



Correct image acquisition

® Use histogram analysis to ensure you collect enough light in the features of
interest

Wave: ™ B17 File Wiew Options Tools Help
Display MindteceExp: |1480.00 1909.00 1.00 E EI ﬂl il EI
Wiiave hinfdass | 480.00 1909.00 1| Z
Section Minfhaxhiean: |480.00 1909.00 1123.15 - A
I Show Histogram _I Log Apply To: . Wave | E
i _
517 /o
Copy Scale l Paste Scale | ~ W— e :
Done | Revert | Restore Default Scale | Help ||FZoom o501 [eimeld T =
mostly camera offset, max value should be
dark signal and below detector saturation
background = avoid saturation

® NOTE - the brightness of the display is not the best indicator of image signal

® Make good use of the dynamic range:8-bit = 255, 12-bit = 4095, 16 bit = 65535
10



Correct image acquisition
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Minimum

Maximum

Brightness

Contrast

Auto Reset

Set Apply

Minimum displayed value: 2200
Maximum displayed value: 7000

Unsigned 16-bit range: Automatic

Propagate to all other open images

Cancel

2475

Bins: 256

6951

Count: 262144 Min: 2475
Mean: 3717.289 Max: 6951
StdDev: 1050.207 Mode: 2522 (17992)

Bin Width: 1/7.484

List Copy Log

4118,.531

Live 258

OK

11



(S/N)

ISe

ise / Sighal to No

No




13

Signal to Noise - definitions:

® One of the most important limitations to image quality and image processing

i mean
Signal

S:N ratio = /V

ariation in the signal S.D.

® Noise is NOT background, auto-fluorescence or dark signal
@® Good image data has a high S:N ratio (>4)

® Fundamental limit = Poisson distributed statistics of photon detection
(shot noise)

Poisson n/
distributed S:N ratio =
variation Vn

@ Statistics of photon counting dictate the minimum useful signal

— TN

Average signal =9, S:N ratio = 3 A meaningful difference in intensity

Average signal = 100, S:N ratio =10 . .

Average signal = 10,000, S:N ratio = 100 needs to be at least three times the noise level
__ -

® Additional sources of noise from digitisation, detector readout, thermal noise.



Signal to noise
- hoise types

Most commonly used noise model for
image processing = Gaussian

% Graussian Rayleigh

Gonzales & Woods, 2002. Digital Image
Processing 2nd Ed. Prentice-Hall Inc, USA.

Gamma

14



How to deal with signal to noise

Acquisition

® Use sensitive, high dynamic range, low noise detectors: cooled CCD, EMCCD

@® Count as many photons as possible:

Bright dyes
Good excitation / emission
Integration time (accumulation or averaging)

Post Acquisition

® Image averaging
® Noise reduction filtering using a spatial filtering mask — 3x3 median filter

® Noise reduction filtering in the frequency domain — Fourier bandpass filter

15



Improving signal to noise

increased signal increases S/N = improved contrast

noisy image
(scaled)

increased number

5x integration time of photons counted

improved S/N

ImageJ

16
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Avoid propagating noise

@ Noise is additive:
SO subtracting one noisy image from another propagates noise

THEREFORE
Subtract an AVERAGE signal to avoid noise propagation

Or

Where the signal is non-uniform across the field subtract a
4x AVERAGED image to avoid noise propagation

http://www.dpcorner.com/topics/
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Resolution and Sampling

18



Optical resolution: The Rayleigh Criterion

Two small objects

CO/zvoIved by Ticroscope

Just

resolved Not resolved
Airy patterns must
Overlap by less
Than 42% of the
Maximal intensities

resolution limit = Aem/2

XY resolution ~ 200 nm
Z. resolution ~ 500 nm

19



Resolution: Nyquist sampling theorem

A sine wave

Sampling 1.5 times per cycle

just sampled
enough

2.3

over sampled

Sampling many times per cycle

vvvvvv

20



Resolution: sampling

Theoretical Axial
Resolution (em 525 nm)

Appropriate Sampling According to Nyquist
theorem - at least half the size

1.4 oil =229 nm

1.35 0il = 237 nm

1.2 water = 267 nm

0.75 air = 427 nm

Nyquist ~ sample at 0.100 um/pixel
Nyquist — sample at 0.103 um/pixel

Nyquist — sample at 0.116 um/pixel

Nyquist — sample at 0.186 um/pixel

® Undersampling limits the data available

Pixel size on Delta
Vision

x100 = 0.063 um/pixel

x60 = 0.106 um/pixel

x40 = 0.158 um/pixel

x20 = 0.317 um/pixel

Interactive tutorial — http://www.microscopyu.com/tutorials/java/digitalimaging/pixelcalculator/ 21
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Resolution, contrast, noise

® Noise limits the contrast which limits the details that can be resolved
= Noise limits resolution

22



Block Black/white lines

Resolution, Y
contrast,

n Boundaries and lines s
noise easily resolved in the

absence of noise

Increasing levels of
Gaussian noise

The difference between
signal and background
must be at least 3X the
noise to be detectable

Decreasing S/N

v

Boundaries and line
no longer resolved-___

Gonzales & Woods, 2002. Digital Image Processing 2nd Ed. Prentice-Hall Inc, USA.

23



) Scaled 0 - 4095 Auto Intensity Scaled display
ReSOI Utl On Full Dynamic range

Contrast
noise

Decreasing S/N

50% Dynamic range

- 10% D -
Image series collected by %o Dynamic range

. TP Increasingly
decre_asmg Fhe excitation Noisy looking
lamp intensity from 100% to

Decreasing

50%, 10%, 1%, and 0.1% Image quality

1% Dynamic range

0.1% Dynamic range v

Cannot resolve
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The basics of image processing

e e e
wiwwy CartoonStock

"l want you to make me the fairest

of them all."

25



Remember what makes a good image

® Good image data has a high S:N ratio (count more photons)

® Correctly sampled to reproduce the optical resolution
(pixel = optical resolution/2)

e Avoid aberrations (sample prep / choice of objective / technique)
- spherical aberration (SA)

- motion blur
- bad system alignment

® Correctly annotated (Metadata retained)

26



Image Processing is NOT a substitute for a good image

27



Golden Rules of Image Processing

Always retain the original data
Do not corrupt the integrity of the original data through
processing:

Processing should NOT generate data not present in the original
image

Images are arrays of numerical data and should be given
appropriate consideration.

Always record and report all processing steps.

28



Fiji =

Image J

http://fij1.sc/wiki/index.php/Fiji

(http://rsb.info.nih.gov/1y/)

® Fiji is FREE and works on MAC, PC and linux
® Consists of a core program and plugins
® Uses Loci Bioformats to convert between file types

- N ~

) Control Pane
Help

» L File
» Gl Edit
v @l Image
» Ll Type
» Gl Adjust
Show Info...
Properties...
» L Color
» [ Stacks
» L Hyperstacks
Crop
Duplicate. .,
Rename...
Scale...
» Ll Transform
» L Zoom
» [ Overlay
» [ Lookup Tables
» [ Annotate
» L Drawing
» L Selection
» L Video Editing
» L Process
» L Analyze
» L Plugins
» Ll Window
» L Help

Gray Value

_ PARSENFNENG P LI CErA

Fiji

—

|[ &’ >

™ grk_MS2GFP_10ms_S0pow..

Fiji Is Just ImageJ

B&C
e 5 For users, Fiji is easy to install and has an
Minimum automatic update function, bundles a |ot of
——_ L lugins and offers comprehensive
= documentation.
Brightness
Con—t—;ast
‘ ( Auto )( Reset )
4 Set ) Apply )

Plot of grk_MS2GFP_10ms_50power_256_20_20120213_Mon-1321_D3

J\/\/V\/M\ﬁ/\

f\

* Graeme, Lecture 19: Applied Image Analysis *
* Practlcal course - Demo of Fiji plugins and macros *

/”\-mf/\f\rJ

0

5

10 15
Distance (microns)

(List )(

Save... [ Copy... |

" Live )
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Do not corrupt the integrity of the original data

@® Retain your original data in its original file format and original metadata
associations

® Consider OME file format for data archiving (lecture 18 - OME, bioformats)
http://loci.wisc.edu/software/bio-formats

® Ideally use Uncompressed TIF (tagged image file format) for processed data

@® AVOID compressed file formats when processing: JPEG, PSD, PDF, compressed
TIF...This will cause data corruption and loss

® Most data is collected as single channel grey scale imac
Avoid saving primary image data in colour formats (RGEM

® Avoid repeated inter-conversions of file formats

® Prepare figures for publication in Adobe Photoshop in
and annotate in Adobe Illustrator

30
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Conceptual Hierarchy of image processing

® Low - level processing = Image enhancement (most common)

® Mid - level processing = Features and attributes extracted

® High - level processing = Analysis = Interpretation of images

Gonzales & Woods (2002). Digital Image Processing 2nd Ed. Prentice-Hall Inc, USA.
31



LOW LEVEL Processing

* Visual enhancement
» Subjective = looks better
* Input is an image, output is an image

- Enhancement Filters
- Adjustments for image Display / Making figures

Contrast

enhancement Median filter

32



LOW LEVEL Processing - Image Restoration

® “Restoration” = attempting to reverse distortions of the object which arise
during image capture

* Flat-field correction - correcting uneven illumination
* Deblurring = Deconvolution, with or without PSF, unsharp mask

* Simple filtering - post acquisition increase in S/N e.g. by averaging

* Graeme, Lecture 19: Applied Image Analysis *

* Normalization - intensity of each time-point scaled to correct bleaching
(or flicker)

* Denoising - post acquisition increase in S/N without loss of resolution

* Image registration - alignment of multiple channels for co-localisation analysis

33



LOW LEVEL Processing - “Background” Correction

® Requires dark image, flat field image and detector calibration

® Detector offset / background
subtract averaged dark value or image

] ] ] original image pseudo-flat field
® Uneven illumination

correct using a flat field image

original/mean-filtfered * mean value

® Uneven detector response

normalise using a detector cali
mapping the response of each pixel —

sudo-corrected

grey level

dark

240x240 mean-filtered | 34
exposure




LOW LEVEL Processing - Simple filtering

Processing in
Real Space or Frequency Space

Fourier
Transform

< AL f e~
X v..‘{,” Sy A - <
: - oo
A 2t "
a"eee -
L8N
° - - ﬁ
4 o
.

Example:

@® Noise reduction filtering using a spatial filtering mask — 3x3 median filter
® Noise reduction filtering in the frequency domain — Fourier bandpass filter

35



LOW LEVEL Processing - Simple filter, spatial domain
e Real space - pixel by pixel

e.g. Noise reduction filtering
using a 3x3 median filter

MEDIAN 3x3:

Replaces value of a pixel by the
median grey scale value of the
ranked values of the 9
neighbourhood pixels.

Gonzales & Woods, 2002. Digital
Image Processing 2nd Ed. Prentice-
Hall Inc, USA.

Image origin

Kernel

Image f(x, v)

Mask

w0,

u(l,—1

fla=1,p-1)

) w1,

w{l, 1)

fix

Ly+1) Mask coefficients, showing

coordinate arrangement

flx+1ly=1)

HAx+Ly+1)

Pixels of image

section under mask

FIGURE 3.32 The
mechanics of
spatial filtering.
The magnified
drawing shows a
3 X 3 mask and
the image section
directly under it;
the image section
is shown
displaced out
from under the
mask for ease of
readability.
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LOW LEVEL Processing - Simple filter, Fourier domain

e Frequency domain - images converted to Fourier space
e.g. Noise reduction using a low pass or band pass filter

Works on the
whole image at
once

Gonzales & Woods,
2002. Digital Image
Processing 2nd Ed.
Prentice-Hall Inc,
USA.

-

——— Fourier “mask” selectively eliminates the
X highest frequencies = noise and very fine
detail.

Can also eliminate large expanses of even
intensity - low frequencies

: Filter [nverse
Fourner : .
— function Fourier
transform _
Huw, v) transform

Flu, v H{w,v)F(u,v)

processing

flx, ¥) of

Input Enhanced
1image image

FIGURE 4.5 Basic steps for filtering in the frequency domain. 37



Fourier Space = Frequency space
= Reciprocal space
= K space

Data is broken down into its “frequency” components

real space reciprocal space

fine detail =
high frequencies

" "=

1D case [\_ —

a Cam= 1/d " ===
Boxcar

Sync Function

fine detail =
high frequencies

585 S -"f@:\lommm..........

2D case

38



LOW LEVEL Processing - Deconvolution
® Blur = out of focus information
An image represents the output of the optics and detector of the imaging system

image = object
image = object ® PSF

® Deblurring = Deconvolution = out of focus information removed or

H microscope optics deconvolutlon
reassigned object— ® —blurred image ——PSF—— corrected image

c>O
o
c>O
o

Ed EN

reversal of the effects of the PSF

39



Different classes of deconvolution

@ Deblurring: nearest neighbours / no neighbours / unsharp mask
Not true deconvolution, subtractive (throws away light)
Quick and easy

@® Image restoration: (inverse filter) constrained iterative algorithms
True deconvolution, light is re-assigned to its point of origin.
Can use measured (empirical), theoretical or derived (blind) PSF



The PSF and OTF

Microscope  _ object ® PSF
Image

But in Fourier space (or frequency space)

FT microscope = FTobject X  FTPSF
Image (“true” image)

@ Calculations for deconvolution are done in Fourier space (simpler / faster)

@ The PSF is Fourier transformed to the OTF (optical transfer function)

@ The inverse calculation to obtain a “true” image = a linear inverse filter



The PSF and OTF

Real space Frequency space

3D - PSF OTF image (API, softWoRXx) Cylindrically

averaged OTF

“Missing Cone”

“Missing Cone” 4{}{/ k,

k=frequency
ke | (Reciprocal space)

@ To simplify deconvolution calculations the OTF is often simplified by
assuming radial symmetry for the PSF

@ The “missing cone” represents missing frequency information not
collected by an objective with a limited NA (not all light can be gathered)




Deconvolution and Noise

PSF
mage _NOISEfct

T

@ Much of the complexity of deconvolution is a direct consequence of having
to deal with “noise” inherent in image data




Constrained iterative deconvolution

Noisy, Raw image Iterations:
compare outcome Modify “guess” and

with raw data ——) €P€at until convolved
outcome approaches

original image

generate
“guess” Expectation is Outcome
equivalent to raw image
constrain and
. noise filter
“Initial Guess”
at true image convolve Best Guess

with PSF =Deconvolution Result




Data requirements for deconvolution

® Ensure that the imaging system is correctly set up, aligned
and calibrated (pixel sizes).

® Reduce aberrations if possible:
Sample preparation and correction of optics
Collect more light / average images
Aim for a high S/N in image data.

® Make sure that images are collected according to the Nyquist
sampling criteria (pixel size in XY and Z step).

® Collect sufficient image planes in Z.
(2D data can be deconvolved but lacks Z information so
restoration is limited.)

® Minimise lamp flicker between Z sections.
(corrected for on the DV system)

® Avoid motion blur from live specimens.
(short exposure times)



Has deconvolution worked?

® Should look sharper and more contrasted and not excessively noisy
® Should NOT “invent” features not visible in the original data
® Be wary of very small punctate features

® Be wary of “ringing” artefacts - dark circles round structures



LOW LEVEL Processing - Making Figures

47



LOW LEVEL Processing - Figure Making Guidelines

Carry out all processing and analysis of images before making
figures by using pixel based (raster) programs: |

Handling of images (tif files) for figures should use pixel based

(raster) programs ‘ 8 Arranging multi-panel figures
e E g“ Cropping, resizing, rotating

Before using vector graphics based programs

m 0 Adding lettering, arrows, charts

diagrams....
Do not prepare figures in powerpoint or keynote or use screen
capture

Understand what happens when you resize an image

Be consistent with processing steps, especially contrasting

48



LOW LEVEL Processing - Display, Grey Scale

DIC/DAPI/Grk in situ - grey scale images

(arrowhead marks the oocyte nucleus)

® For viewing and display use grey scale scale images to see fine detail.

49



LOW LEVEL Processing - Display, Brightness/Contrast

e Brightness and contrast - Enhancing details which are too close in grey
level to be easily discernible.

= | Scale Image: Window 2 = | 2: Window - GRK_insita_R3D.dv =3l
Wave: “ B17 File Wiew Options Tools Help
P .
Display MinfhﬂaﬂE](p:

B8O

Wave hinfax: | 450.00 1909.00

Section Mina’hﬂaﬂhﬂe?n'\[ﬂﬂﬂiﬂﬂ 1909.00 1123.15 _ 7/
~
7 Show Histogram _{ Log ™ AppheTes —aue |

Better to set your contrast
by numbers

to make the operation more
systematic

0-4095 is full range for 12 bit

Copy Scale | Paste Scale |

Daone | Rewvert | Festore Default Scale | Help (Zoom: 0.50) |51_;|1'[|H- | P
= Scale Image: Window 1 —[E [ =1 Window - GRE_insita |30 dv E=ES
Wave: “* B17 File ‘iew thinns IIDD|S Help
Display Mindtdax/Exp: 450,00 1908.00 1.00 Ef; Elﬂl - Auto-intensity scaling
Wave Minfiax: | 480,00 1909.00 | Z e G % by softWoRXx scales
Section Minfvax/hean: 480.00 1909.00 1123.15 - A the dlsplay
7 Show Histogram _{Log ~ ApplyTo: _ Wave — ||} em to fill the dynamic range
34
{o}
B17 A

Copy Scale | Paste Scale | i

‘ Done | Rewvert | Restore Default Scale | Help “ (Zoom: 0.50] (8178l T~ SOftWORX; API 50




LOW LEVEL Processing - Display, Bit Depth (levels)

® “grey levels” = the number of discrete values in an image

Imaging detectors:
® Dynamic range = the number of possible grey levels 8 bit = 28 = 256 grey levels
12 bit = 212 = 4096 grey levels
® Eye has limited ability to distinguish grey levels/colours 16 bit=21°=65536 grey levels
Above 32 grey levels images look smooth - 16 and below grey levels eye perceives
objectionable banding = false contours.

False contouring due to insufficient grey levels ———

8 bit - 256 greys 16 greys 4 greys

dynamic range filled

S

0

256 256 0 256
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LOW LEVEL Processing - Display, Using Gamma

true image Image as viewed on monitor

uncorrected

D _ e
M 1 i\ -,
[-1.- Monitor jl_m},

/ ;’i
Il
f""'_-__{_iilllﬁy‘l_u__""‘ :
correction Correctly viewed image
7 Image as viewed on moniton
corrected

B,

I_Iri"-. NMaoniton ',

Gonzales & Woods, 2002. Digital Image Processing 2nd Ed. Prentice-Hall Inc, USA.



LOW LEVEL Processing - Display, Colour N

DIC/DAPI/Grk in situ - grey scale images, colour blended, additive overlays
= Look-Up Tables (LUTs) map intensity to color

(arrowhead marks the oocyte nucleus)

@ Colour should be used for highlighting particular intensity differences / co-localisation.

@® For publication show greyscale images alongside colour overlays.

softwoRx API



LOW LEVEL Processing - Display, Colour

® Consider colour blind friendly colours: magenta, green




LOW LEVEL Processing - Display, Making Movies

® Movie formats: .avi; .mov; (.mpeg)

® Considerations:
image quality vs movie size (use of compression).
speed of play (frames / second).
speed of play on the computer may be slowed by large movies

e ImageJ

Will open many file formats and export straight to .avi or .mov.,
also can open tif image series (image001.tif; image002.tif; etc)

restack and export to .avi

® Quicktime Pro 7

Can open tif image series and export to .avi or . mov
Can interconvert movie formats.
Has a range of compression options for .mov

99



Bad Imaging Practices

Do not corrupt the integrity of the
original data



Examples of Bad Imaging Practices

Rossner & Yamada (2004). What's in a picture? The temptation of image manipulation. J. Cell
Biology 166: 11-15.

Original image Manipulated image

N

T
A

i |

Figure 5. Misrepresentation of immunogold data. The gold particles, which were actually
present in the original (left), have been enhanced in the manipulated image (right). Note also
that the background dot in the original data has been removed in the manipulated image.

® BAD: manipulated but does not alter interpretation

@® VERY BAD: Changes interpretation with intention to defraud

@® Adjustments necessary to reveal a feature ALREADY PRESENT in the
original data are acceptable if they can be justified

S7



THEY
HAVE
WAYS
OF
FINDING
OUT
WHAT
YOU
DID!
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® Miss-representation of cell population
within an oberved field

Manipulated
p1 ® VERY BAD: Changes interpretation with
IFiage intention to defraud
Correct:
Manipulation
revealed
by contrast » .
adjustment

Rossner & Yamada (2004). What's in a picture? The temptation of image manipulation. J. Cell
Biology 166: 11-15. 59



MID LEVEL Processing

* Input is an image, output is an attribute extracted
from the image

Objects

Segmentation Jofined

Number of objects
Positions of objects
Size of objects
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MID LEVEL Processing - simple segmentation 61
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The human brain is still one of the best segmentation tools
But

Subjective not objective!

Automated segmentation desirable for data quality and sanity

* Graeme, Lecture 19: Applied Image Analysis *
* Practical course - Demo of Fiji plugins and macros *
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HIGH LEVEL Processing = Image Analysis

® Outputs are interpretation (making sense)

Automated Particle tracking

—>

Particle velocities

X cent | ycent |dist | At | Velocity

Particle trajectories
Particle velocities
Run lengths
Directionality

Net directionality

* Graeme, Lecture 19: Applied Image Analysis *
* Practical course - Demo of Fiji plugins and macros *



END
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